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CHAP T ER  1 

Introduction to 
Computer Graphics 

The importance of computer graphics in modern society is 
illustrated by the great quantity and variety of applications and their 

impact on our daily lives. Computer graphics can be two-dimensional (2D) 
or three-dimensional (3D), animated, and interactive. Tey are used in 
data visualization to identify patterns and relationships, and also in scien-
tifc visualization, enabling researchers to model, explore, and understand 
natural phenomena. Computer graphics are used for medical applications, 
such as magnetic resonance imaging (MRI) and computed tomography 
(CT) scans, and architectural applications, such as creating blueprints or 
virtual models. Tey enable the creation of tools such as training simu-
lators and sofware for computer-aided engineering and design. Many 
aspects of the entertainment industry make use of computer graphics to 
some extent: movies may use them for creating special efects, generat-
ing photorealistic characters, or rendering entire flms, while video games 
are primarily interactive graphics-based experiences. Recent advances in 
computer graphics hardware and sofware have even helped virtual reality 
and augmented reality technology enter the consumer market. 

Te feld of computer graphics is continuously advancing, fnding new 
applications, and increasing in importance. For all these reasons, combined 
with the inherent appeal of working in a highly visual medium, the feld 
of computer graphics is an exciting area to learn about, experiment with, 
and work in. In this book, you’ll learn how to create a robust framework 

DOI: 10.1201/9781003181378-1 1 
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2 ◾ Developing Graphics Frameworks with Python and OpenGL 

capable of rendering and animating interactive three-dimensional scenes 
using modern graphics programming techniques. 

Before diving into programming and code, you’ll frst need to learn 
about the core concepts and vocabulary in computer graphics. Tese ideas 
will be revisited repeatedly throughout this book, and so it may help to 
periodically review parts of this chapter to keep the overall process in 
mind. In the second half of this chapter, you’ll learn how to install the 
necessary sofware and set up your development environment. 

1.1 CORE CONCEPTS AND VOCABULARY 
Our primary goal is to generate two-dimensional images of three-
dimensional scenes; this process is called rendering the scene. Scenes 
may contain two- and three-dimensional objects, from simple geometric 
shapes such as boxes and spheres, to complex models representing real-
world or imaginary objects such as teapots or alien lifeforms. Tese objects 
may simply appear to be a single color, or their appearance may be afected 
by textures (images applied to surfaces), light sources that result in shading 
(the darkness of an object not in direct light) and shadows (the silhouette 
of one object's shape on the surface of another object), or environmen-
tal properties such as fog. Scenes are rendered from the point of view of 
a virtual camera, whose relative position and orientation in the scene, 
together with its intrinsic properties such as angle of view and depth of 
feld, determine which objects will be visible or partially obscured by 
other objects when the scene is rendered. A 3D scene containing multiple 
shaded objects and a virtual camera is illustrated in Figure 1.1. Te region 
contained within the truncated pyramid shape outlined in white (called a 
frustum) indicates the space visible to the camera. In Figure 1.1, this region 
completely contains the red and green cubes, but only contains part of the 
blue sphere, and the yellow cylinder lies completely outside of this region. 
Te results of rendering the scene in Figure 1.1 are shown in Figure 1.2. 

From a more technical, lower-level perspective, rendering a scene 
produces a raster—an array of pixels (picture elements) which will be 
displayed on a screen, arranged in a two-dimensional grid. Pixels are typi-
cally extremely small; zooming in on an image can illustrate the presence 
of individual pixels, as shown in Figure 1.3. 

On modern computer systems, pixels specify colors using triples of 
foating-point numbers between 0 and 1 to represent the amount of red, 
green, and blue light present in a color; a value of 0 represents no amount 
of that color is present, while a value of 1 represents that color is displayed 



      

 

 

 

Introduction to Computer Graphics ◾ 3 

FIGURE 1.1 Tree-dimensional scene with geometric objects, viewing region 
(white outline) and virtual camera (lower right). 

FIGURE 1.2 Results of rendering the scene from Figure 1.1 

FIGURE 1.3 Zooming in on an image to illustrate individual pixels. 



      

 

 

   

 
  

 

        
       

4 ◾ Developing Graphics Frameworks with Python and OpenGL 

FIGURE 1.4 Various colors and their corresponding (R, G, B) values. 

at full (100%) intensity. Tese three colors are typically used since photore-
ceptors in the human eye take in those particular colors. Te triple (1, 0, 0) 
represents red, (0, 1, 0) represents green, and (0, 0, 1) represents blue. Black 
and white are represented by (0, 0, 0) and (1, 1, 1), respectively. Additional 
colors and their corresponding triples of values specifying the amounts of 
red, green, and blue (ofen called RGB values) are illustrated in Figure 1.4. 

Te quality of an image depends in part on its resolution (the number of 
pixels in the raster) and precision (the number of bits used for each pixel). 
As each bit has two possible values (0 or 1), the number of colors that can 
be expressed with N-bit precision is 2N . For example, early video game 
consoles with 8-bit graphics were able to display 28 = 256 diferent colors. 
Monochrome displays could be said to have 1-bit graphics, while modern 
displays ofen feature “high color” (16-bit, 65,536 color) or “true color” 
(24-bit, more than 16 million colors) graphics. Figure 1.5 illustrates the 
same image rendered with high precision but diferent resolutions, while 
Figure 1.6 illustrates the same image rendered with high resolution but 
diferent precision levels. 

In computer science, a bufer (or data bufer, or bufer memory) is a part 
of a computer's memory that serves as temporary storage for data while 
it is being moved from one location to another. Pixel data is stored in a 
region of memory called the framebufer. A framebufer may contain mul-
tiple bufers that store diferent types of data for each pixel. At a minimum, 
the framebufer must contain a color bufer, which stores RGB values. 
When rendering a 3D scene, the framebufer must also contain a depth 
bufer, which stores distances from points on scene objects to the virtual 
camera. Depth values are used to determine whether the various points 
on each object are in front of or behind other objects (from the camera’s 
perspective), and thus whether they will be visiblewhen the scene is ren-
dered. If one scene object obscures another and a transparency efect is 
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FIGURE 1.5 A single image rendered with diferent resolutions. 

FIGURE 1.6 A single image rendered with diferent precisions. 
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desired, the renderer makes use of alpha values: foating-point numbers 
between 0 and 1 that specifes how overlapping colors should be blended 
together; the value 0 indicates a fully transparent color, while the value 
1 indicates a fully opaque color. Alpha values are also stored in the color 
bufer along with RGB color values; the combined data is ofen referred to 
as RGBA color values. Finally, framebufers may contain a bufer called 
a stencil bufer, which may be used to store values used in generating 
advanced efects, such as shadows, refections, or portal rendering. 

In addition to rendering three-dimensional scenes, another goal in 
computer graphics is to create animated scenes. Animations consist of a 
sequence of images displayed in quick enough succession that the viewer 
interprets the objects in the images to be continuously moving or chang-
ing in appearance. Each image that is displayed is called a frame. Te 
speed at which these images appear is called the frame rate and is mea-
sured in frames per second (FPS). Te standard frame rate for movies and 
television is 24 FPS. Computer monitors typically display graphics at 60 
FPS. For virtual reality simulations, developers aim to attain 90 FPS, as 
lower frame rates may cause disorientation and other negative side efects 
in users. Since computer graphics must render these images in real time, 
ofen in response to user interaction, it is vital that computers be able to 
do so quickly. 

In the early 1990s, computers relied on the central processing unit (CPU) 
circuitry to perform the calculations needed for graphics. As real-time 3D 
graphics became increasingly common in video game platforms (including 
arcades, gaming consoles, and personal computers), there was increased 
demand for specialized hardware for rendering these graphics. Tis led to 
the development of the graphics processing unit (GPU), a term coined by the 
Sony Corporation that referred to the circuitry in their PlayStation video 
game console, released in 1994. Te Sony GPU performed graphics-related 
computational tasks including managing a framebufer, drawing polygons 
with textures, and shading and transparency efects. Te term GPU was 
popularized by the NVidia Corporation in 1999 with their release of the 
GeForce 256, a single-chip processor that performed geometric transfor-
mations and lighting calculations in addition to the rendering computa-
tions performed by earlier hardware implementations. NVidia was the frst 
company to produce a GPU capable of being programmed by developers: 
each geometric vertex could be processed by a short program, as could 
every rendered pixel, before the resulting image was displayed on screen. 
Tis processor, the GeForce 3, was introduced in 2001 and was also used 
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in the Xbox video game console. In general, GPUs feature a highly parallel 
structure that enables them to be more efcient than CPUs for rendering 
computer graphics. As computer technology advances, so does the quality 
of the graphics that can be rendered; modern systems are able to produce 
real-time photorealistic graphics at high resolutions. 

Programs that are run by GPUs are called shaders, initially so named 
because they were used for shading efects, but now used to perform many 
diferent computations required in the rendering process. Just as there are 
many high-level programming languages (such as Java, JavaScript, and 
Python) used to develop CPU-based applications, there are many shader 
programming languages. Each shader language implements an application 
programming interface (API), which defnes a set of commands, functions, 
and protocols that can be used to interact with an external system—in this 
case, the GPU. Some APIs and their corresponding shader languages include 

• Te DirectX API and High-Level Shading Language (HLSL), used on 
Microsof platforms, including the Xbox game console 

• Te Metal API and Metal Shading Language, which runs on modern 
Mac computers, iPhones, and iPads 

• Te OpenGL (Open Graphics Library) API and OpenGL Shading 
Language (GLSL), a cross-platform library. 

Tis book will focus on OpenGL, as it is the most widely adopted graphics 
API. As a cross-platform library, visual results will be consistent on any 
supported operating system. Furthermore, OpenGL can be used in con-
cert with a variety of high-level languages using bindings: sofware librar-
ies that bridge two programming languages, enabling functions from one 
language to be used in another. For example, some bindings to OpenGL 
include 

• JOGL (https://jogamp.org/jogl/www/) for Java 

• WebGL (https://www.khronos.org/webgl/) for JavaScript 

• PyOpenGL (http://pyopengl.sourceforge.net/) for Python 

Te initial version of OpenGL was released by Silicon Graphics, Inc. (SGI) 
in 1992 and has been managed by the Khronos Group since 2006. Te 
Khronos Group is a non-proft technology consortium, whose members 

https://jogamp.org
https://www.khronos.org
http://pyopengl.sourceforge.net
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include graphics card manufacturers and general technology companies. 
New versions of the OpenGL specifcation are released regularly to support 
new features and functions. In this book, you will learn about many of the 
OpenGL functions that allow you to take advantage of the graphics capa-
bilities of the GPU and render some truly impressive three-dimensional 
scenes. Te steps involved in this rendering process are described in detail 
in the sections that follow. 

1.2 THE GRAPHICS PIPELINE 
A graphics pipeline is an abstract model that describes a sequence of steps 
needed to render a three-dimensional scene. Pipelining allows a compu-
tational task to be split into subtasks, each of which can be worked on 
in parallel, similar to an assembly line for manufacturing products in a 
factory, which increases overall efciency. Graphics pipelines increase 
the efciency of the rendering process, enabling images to be displayed 
at faster rates. Multiple pipeline models are possible; the one described 
in this section is commonly used for rendering real-time graphics using 
OpenGL, which consists of four stages (illustrated by Figure 1.7): 

• Application Stage: initializing the window where rendered graphics 
will be displayed; sending data to the GPU 

• Geometry Processing: determining the position of each vertex of the 
geometric shapes to be rendered, implemented by a program called 
a vertex shader 

• Rasterization: determining which pixels correspond to the geometric 
shapes to be rendered 

• Pixel Processing: determining the color of each pixel in the rendered 
image, involving a program called a fragment shader 

Each of these stages is described in more detail in the sections that follow; 
the next chapter contains code that will begin to implement many of the 
processes described here. 

FIGURE 1.7 Te graphics pipeline. 
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1.2.1 Application Stage 

Te application stage primarily involves processes that run on the CPU. 
One of the frst tasks is to create a window where the rendered graphics 
will be displayed. When working with OpenGL, this can be accomplished 
using a variety of programming languages. Te window (or a canvas-like 
object within the window) must be initialized so that the graphics are read 
from the GPU framebufer. In the case of animated or interactive appli-
cations, the main application contains a loop that re-renders the scene 
repeatedly, typically aiming for a rate of 60 FPS. Other processes that may 
be handled by the CPU include monitoring hardware for user input events, 
or running algorithms for tasks such as physics simulation and collision 
detection. 

Another class of tasks performed by the application includes read-
ing data required for the rendering process and sending it to the GPU. 
Tis data may include vertex attributes (which describe the appearance 
of the geometric shapes being rendered), images that will be applied to 
surfaces, and source code for the vertex shader and fragment shader pro-
grams (which will be used later on during the graphics pipeline). OpenGL 
describes the functions that can be used to transmit this data to the GPU; 
these functions are accessed through the bindings of the programming 
language used to write the application. Vertex attribute data is stored in 
GPU memory bufers called vertex bufer objects (VBOs), while images 
that will be used as textures are stored in texture bufers. It is important 
to note that this stored data is not initially assigned to any particular pro-
gram variables; these associations are specifed later. Finally, source code 
for the vertex shader and fragment shader programs needs to be sent to 
the GPU, compiled, and loaded. If needed, bufer data can be updated dur-
ing the application's main loop, and additional data can be sent to shader 
programs as well. 

Once the necessary data has been sent to the GPU, before rendering 
can take place, the application needs to specify the associations between 
attribute data stored in VBOs and attribute variables in the vertex shader 
program. A single geometric shape may have multiple attributes for each 
vertex (such as position and color), and the corresponding data is streamed 
from bufers to variables in the shader during the rendering process. It 
is also frequently necessary to work with many sets of such associations: 
there may be multiple geometric shapes (with data stored in diferent buf-
fers) that are rendered by the same shader program, or each shape may be 
rendered by a diferent shader program. Tese sets of associations can be 
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FIGURE 1.8 Wireframe meshes representing a sphere and a teapot. 

conveniently managed by using vertex array objects (VAOs), which store 
this information and can be activated and deactivated as needed during 
the rendering process. 

1.2.2 Geometry Processing 

In computer graphics, the shape of a geometric object is defned by a mesh: 
a collection of points that are grouped into lines or triangles, as illustrated 
in Figure 1.8. 

In addition to the overall shape of an object, additional information 
may be required to describe how the object should be rendered. Te prop-
erties or attributes that are specifc to rendering each individual point are 
grouped together into a data structure called a vertex. At a minimum, a 
vertex must contain the three-dimensional position of the corresponding 
point. Additional data contained by a vertex ofen includes 

• a color to be used when rendering the point 

• texture coordinates (or UV coordinates), which indicate a point in an 
image that is mapped to the vertex 

• a normal vector, which indicates the direction perpendicular to a 
surface and is typically used in lighting calculations 

Figure 1.9 illustrates diferent renderings of a sphere that make use of these 
attributes. Additional vertex attributes may be defned as needed. 

During the geometry processing stage, the vertex shader is applied to 
each of the vertices; each attribute variable in the shader receives data 
from a bufer according to previously specifed associations. Te pri-
mary purpose of the vertex shader is to determine the fnal position of 
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FIGURE 1.9 Diferent renderings of a sphere: wireframe, vertex colors, texture, 
and with lighting efects. 

FIGURE 1.10 One scene rendered from multiple camera locations and angles. 

each point being rendered, which is typically calculated from a series of 
transformations: 

• the collection of points defning the intrinsic shape of an object may 
be translated, rotated, and scaled so that the object appears to have 
a particular location, orientation, and size with respect to a virtual 
three-dimensional world. Tis process is called the model transfor-
mation; coordinates expressed from this frame of reference are said 
to be in world space 

• there may be a virtual camera with its own position and orientation 
in the virtual world. In order to render the world from the camera’s 
point of view, the coordinates of each object in the world must be 
converted to a frame of reference relative to the camera itself. Tis 
process is called the view transformation, and coordinates in this 
context are said to be in view space (or camera space, or eye space). 
Te efect of the placement of the virtual camera on the rendered 
image is illustrated in Figure 1.10 

• the set of points in the world considered to be visible, occupying 
either a box-shaped or frustum-shaped region, must be scaled to and 
aligned with the space rendered by OpenGL: a cube-shaped region 
consisting of all points whose coordinates are between −1 and 1. 
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FIGURE 1.11 A series of cubes rendered with orthogonal projection (a) and 
perspective projection (b). 

Te position of each point returned by the vertex shader is assumed 
to be expressed in this frame of reference. Any points outside this 
region are automatically discarded or clipped from the scene; coor-
dinates expressed at this stage are said to be in clip space. Tis task is 
accomplished with a projection transformation. More specifcally, it is 
called an orthographic projection or a perspective projection, depend-
ing on whether the shape of the visible world region is a box or a 
frustum. A perspective projection is generally considered to produce 
more realistic images, as objects that are farther away from the vir-
tual camera will require greater compression by the transformation 
and thus appear smaller when the scene is rendered. Te diferences 
between the two types of projections are illustrated in Figure 1.11. 

In addition to these transformation calculations, the vertex shader may 
perform additional calculations and send additional information to the 
fragment shader as needed. 

1.2.3 Rasterization 

Once the fnal positions of each vertex have been specifed by the vertex 
shader, the rasterization stage begins. Te points themselves must frst be 
grouped into the desired type of geometric primitive: points, lines, or tri-
angles, which consist of sets of 1, 2, or 3 points. In the case of lines or 
triangles, additional information must be specifed. For example, consider 
an array of points [A, B, C, D, E, F] to be grouped into lines. Tey could 
be grouped in disjoint pairs, as in (A, B), (C, D), (E, F), resulting in a set 
of disconnected line segments. Alternatively, they could be grouped in 
overlapping pairs, as in (A, B), (B, C), (C, D), (D, E), (E, F), resulting in a 
set of connected line segments (called a line strip). Te type of geometric 
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primitive and method for grouping points is specifed using an OpenGL 
function parameter when the rendering process begins. Te process of 
grouping points into geometric primitives is called primitive assembly. 

Once the geometric primitives have been assembled, the next step is to 
determine which pixels correspond to the interior of each geometric prim-
itive. Since pixels are discrete units, they will typically only approximate 
the continuous nature of a geometric shape, and a criterion must be given 
to clarify which pixels are in the interior. Tree simple criteria could be

 1. the entire pixel area is contained within the shape

 2. the center point of the pixel is contained within the shape

 3. any part of the pixel is contained within the shape 

Tese efects of applying each of these criteria to a triangle are illustrated 
in Figure 1.12, where the original triangle appears outlined in blue, and 
pixels meeting the criteria are shaded gray. 

For each pixel corresponding to the interior of a shape, a fragment is 
created: a collection of data used to determine the color of a single pixel in 
a rendered image. Te data stored in a fragment always includes the raster 
position, also called pixel coordinates. When rendering a three-dimensional 
scene, fragments will also store a depth value, which is needed when points 
on diferent geometric objects would overlap from the perspective of the 
viewer. When this happens, the associated fragments would correspond 
to the same pixel, and the depth value determines which fragment’s data 
should be used when rendering this pixel. 

Additional data may be assigned to each vertex, such as a color, and 
passed along from the vertex shader to the fragment shader. In this case, a 
new data feld is added to each fragment. Te value assigned to this feld at 

FIGURE 1.12 Diferent criteria for rasterizing a triangle. 
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FIGURE 1.13 Interpolating color attributes. 

each interior point is interpolated from the values at the vertices: calculated 
using a weighted average, depending on the distance from the interior 
point to each vertex. Te closer an interior point is to a vertex, the greater 
the weight of that vertex’s value when calculating the interpolated value. 
For example, if the vertices of a triangle are assigned the colors red, green, 
and blue, then each pixel corresponding to the interior of the triangle will 
be assigned a combination of these colors, as illustrated in Figure 1.13. 

1.2.4 Pixel Processing 

Te primary purpose of this stage is to determine the fnal color of each 
pixel, storing this data in the color bufer within the framebufer. During 
the frst part of the pixel processing stage, a program called the fragment 
shader is applied to each of the fragments to calculate their fnal color. Tis 
calculation may involve a variety of data stored in each fragment, in com-
bination with data globally available during rendering, such as 

• a base color applied to the entire shape 

• colors stored in each fragment (interpolated from vertex colors) 
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FIGURE 1.14 An image fle (a) used as a texture for a 3D object (b). 

• textures (images applied to the surface of the shape, illustrated by 
Figure 1.14), where colors are sampled from locations specifed by 
texture coordinates 

• light sources, whose relative position and/or orientation may lighten 
or darken the color, depending on the direction the surface is facing 
at a point, specifed by normal vectors 

Some aspects of the pixel processing stage are automatically handled by 
the GPU. For example, the depth values stored in each fragment are used 
in this stage to resolve visibility issues in a three-dimensional scene, deter-
mining which parts of objects are blocked from view by other objects. 
Afer the color of a fragment has been calculated, the fragment’s depth 
value will be compared to the value currently stored in the depth bufer 
at the corresponding pixel coordinates. If the fragment's depth value is 
smaller than the depth bufer value, then the corresponding point is closer 
to the viewer than any that were previously processed, and the fragment’s 
color will be used to overwrite the data currently stored in the color bufer 
at the corresponding pixel coordinates. 

Transparency is also handled by the GPU, using the alpha values stored 
in the color of each fragment. Te alpha value of a color is used to indicate 
how much of this color should be blended with another color. For example, 
when combining a color C1 with an alpha value of 0.6 with another color 
C2, the resulting color will be created by adding 60% of the value from 
each component of C1 to 40% of the value from each component of C2. 
Figure 1.15 illustrates a simple scene involving transparency. 
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FIGURE 1.15 Rendered scene with transparency. 

However, rendering transparent objects has some complex subtleties. 
Tese calculations occur at the same time that depth values are being 
resolved, and so scenes involving transparency must render objects in a 
particular order: all opaque objects must be rendered frst (in any order), 
followed by transparent objects ordered from farthest to closest with respect 
to the virtual camera. Not following this order may cause transparency 
efects to fail. For example, consider a scene, such as that in Figure 1.15, 
containing a single transparent object close to the camera and multiple 
opaque objects farther from the camera that appear behind the transparent 
object. Assume that, contrary to the previously described rendering order, 
the transparent object is rendered frst, followed by the opaque objects in 
some unknown order. When the fragments of the opaque objects are pro-
cessed, their depth value will be greater than the value stored in the depth 
bufer (corresponding to the closer transparent object), and so the opaque 
fragments’ color data will automatically be discarded, rather than blended 
with the currently stored color. Even attempting to use the alpha value of 
the transparent object stored in the color bufer in this example does not 
resolve the underlying issue, because when the fragments of each opaque 
object are being rendered, it is not possible at this point to determine if 
they may have been occluded from view by another opaque fragment (only 
the closest depth value, corresponding to the transparent object, is stored), 
and thus, it is unknown which opaque fragment's color values should be 
blended into the color bufer. 
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1.3 SETTING UP A DEVELOPMENT ENVIRONMENT 
Most parts of the graphics pipeline discussed in the previous section— 
geometry processing, rasterization, and pixel processing—are handled 
by the GPU, and as mentioned previously, this book will use OpenGL for 
these tasks. For developing the application, there are many programming 
languages one could select from. In this book, you will be using Python 
to develop these applications, as well as a complete graphics framework 
to simplify the design and creation of interactive, animated, three-
dimensional scenes. 

1.3.1 Installing Python 

To prepare your development environment, the frst step is to download 
and install a recent version of Python (version 3.8 as of this writing) from 
http://www.python.org (Figure 1.16); installers are available for Windows, 
Mac OS X, and a variety of other platforms. 

• When installing for Windows, check the box next to add to path. 
Also, select the options custom installation and install for all users; 
this simplifes setting up alternative development environments later. 

Te Python installer will also install IDLE, Python’s Integrated 
Development and Learning Environment, which can be used for devel-
oping the graphics framework presented throughout this book. A more 

FIGURE 1.16 Python homepage: http://www.python.org. 

http://www.python.org
http://www.python.org
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sophisticated alternative is recommended, such as Sublime Text, which 
will be introduced later on in this chapter, and some of its advantages 
discussed. (If you are already familiar with an alternative Python 
development environment, you are of course also welcome to use that 
instead.) 

IDLE has two main window types. Te frst window type, which auto-
matically opens when you run IDLE, is the shell window, an interactive 
window that allows you to write Python code which is then immediately 
executed afer pressing the Enter key. Figure 1.17 illustrates this win-
dow afer entering the statements 123 + 214 and print("Hello, 
world!"). Te second window type is the editor window, which func-
tions as a text editor, allowing you to open, write, and save fles containing 
Python code, which are called modules and typically use the.py fle exten-
sion. An editor window can be opened from the shell window by selecting 
either File > New File or File > Open... from the menu bar. Programs may 
be run from the editor window by choosing Run > Run Module from the 
menu bar; this will display the output in a shell window (opening a new 
shell window if none are open). Figure 1.18 illustrates creating a fle in the 
editor window containing the following code: 

print("Hello, world!") 
print("Have a nice day!") 

FIGURE 1.17 IDLE shell window. 

FIGURE 1.18 IDLE editor window. 
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FIGURE 1.19 Results of running the Python program from Figure 1.18. 

Figure 1.19 illustrates the results of running this code, which appear in a 
shell window. 

1.3.2 Python Packages 

Once Python has been successfully installed, your next step will be to 
install some packages, which are collections of related modules that pro-
vide additional functionality to Python. Te easiest way to do this is by 
using pip, a sofware tool for package installation in Python. In particular, 
you will install 

• Pygame (http://www.pygame.org), a package that can be used to 
easily create windows and handle user input 

• Numpy (https://numpy.org/), a package for mathematics and scientifc 
computing 

• PyOpenGL and PyOpenGL_accelerate (http://pyopengl.sourceforge. 
net/), which provide a set of bindings from Python to OpenGL. 

If you are using Windows, open Command Prompt or PowerShell (run 
with administrator privileges so that the packages are automatically avail-
able to all users) and enter the following command, which will install all 
of the packages described above: 

py -m pip install pygame numpy PyOpenGL 
PyOpenGL_accelerate 

If you are using MacOS, the command is slightly diferent. Enter 

python3-m pip install pygame numpy PyOpenGL 
PyOpenGL_accelerate 

http://www.pygame.org
https://numpy.org
http://pyopengl.sourceforge.net
http://pyopengl.sourceforge.net
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To verify that these packages have been installed correctly, open a new 
IDLE shell window (restart IDLE if it was open before installation). To 
check Pygame, enter the following code, and press the Enter key: 

import pygame 

You should see a message that contains the number of the Pygame 
version that has been installed, such as "pygame 1.9.6", and a greet-
ing message such as "Hello from the pygame community". If 
instead you see a message that contains the text No module named 
'pygame', then Pygame has not been correctly installed. Furthermore, 
it will be important to install a recent version of Pygame—at least a 
development version of Pygame 2.0.0. If an earlier version has been 
installed, return to the command prompt and in the install command 
above, change pygame to pygame==2.0.0.dev10 to install a more 
recent version. 

Similarly, to check the Numpy installation, instead use the code: 

import numpy 

In this case, if you see no message at all (just another input prompt), then 
the installation was successful. If you see a message that contains the text 
No module named 'numpy', then Numpy has not been correctly 
installed. Finally, to check PyOpenGL, instead use the code: 

import OpenGL 

As was the case with testing the Numpy package, if there is no message 
displayed, then the installation was successful, but a message mentioning 
that the module is not installed will require you to try re-installing the 
package. 

If you encounter difculties installing any of these packages, there is 
additional help available online: 

• Pygame: https://www.pygame.org/wiki/GettingStarted 

• Numpy: https://numpy.org/install/ 

• PyOpenGL: at http://pyopengl.sourceforge.net/documentation/ 
installation.html 

https://www.pygame.org
https://numpy.org
http://pyopengl.sourceforge.net
http://pyopengl.sourceforge.net
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1.3.3 Sublime Text 

When working on a large project involving multiple fles, you may want to 
install an alternative development environment, rather than restrict your-
self to working with IDLE. Te authors particularly recommend Sublime 
Text, which has the following advantages: 

• lines are numbered for easy reference 

• tabbed interface for working with multiple fles in a single window 

• editor supports multi-column layout to view and edit diferent fles 
simultaneously 

• directory view to easily navigate between project fles in a project 

• able to run scripts and display output in console area 

• free, full-featured trial version available 

To install the application, visit the Sublime Text website (https://www. 
sublimetext.com/), shown in Figure 1.20, and click on the “download” 
button (whose text may difer from the fgure to reference the operating 
system you are using). Alternatively, you may click the download link in 
the navigation bar to view all downloadable versions. Afer downloading, 
you will need to run the installation program, which will require 
administrator-level privileges on your system. If unavailable, you may 
alternatively download a “portable version” of the sofware, which can 

FIGURE 1.20 Sublime Text homepage 

https://www.sublimetext.com
https://www.sublimetext.com
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FIGURE 1.21 Sublime Text editor window. 

FIGURE 1.22 Output from Figure 1.21. 

be found via the download link previously mentioned. While a free trial 
version is available, if you choose to use this sofware extensively, you are 
encouraged to purchase a license. 

Afer installation, start the Sublime Text sofware. A new editor window 
will appear, containing an empty fle. As previously mentioned, Sublime 
Text can be used to run Python scripts automatically, provided that Python 
has been installed for all users of your computer and it is included on the 
system path. To try out this feature, in the editor window, as shown in 
Figure 1.21, enter the text: 

print("Hello, world!") 

Next, save your fle with the name test.py; the.py extension causes 
Sublime Text to recognize it as a Python script fle, and syntax highlighting 
will be applied. Finally, from the menu bar, select Tools > Build or press 
the keyboard key combination Ctrl + B to build and run the application. 
Te output will appear in the console area, as illustrated in Figure 1.22. 
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1.4 SUMMARY AND NEXT STEPS 
In this chapter, you learned about the core concepts and vocabulary used 
in computer graphics, including rendering, bufers, GPUs, and shaders. 
Ten, you learned about the four major stages in the graphics pipeline: the 
application stage, geometry processing, rasterization, and pixel processing; 
this section introduced additional terminology, including vertices, 
VBOs, VAOs, transformations, projections, fragments, and interpolation. 
Finally, you learned how to set up a Python development environment. In 
the next chapter, you will use Python to start implementing the graphics 
framework that will realize these theoretical principles. 
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